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Information about this document
The warnings and notes in this document mean the following:

A

WARNING!
Risk of personal injury. Could result in serious injury or death.

A

CAUTION!
Risk of personal injury. Could result in injury or pose a risk
of health.

NOTICE!
Risk of damage to property.

Note:
Tips and important information.
Numbered lists (numbers, letters) are used for:
●● Instructions that must be followed in a certain order
Lists with bullet points (point, dash) are used for:
●● Lists
●● Instructions that only involve one step
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Introduction

1.1

Warranty
The following instructions must be complied with in order for any
warranty to be applicable regarding functionality and safe operation of this equipment.
●● Read these operating instructions prior to operating the product.
●● Use the product only as intended.
●● Repairs and maintenance must only be carried out by specialist technicians or other suitably trained personnel. Only spare
parts approved by Hermann Sewerin GmbH may be used
when performing repairs.
●● Changes or modifications to this product may only be carried
out with the approval of Hermann Sewerin GmbH.
●● Use only Hermann Sewerin GmbH accessories for the product.
Hermann Sewerin GmbH shall not be liable for damages resulting from the non-observance of this information. The warranty
conditions of the General Terms and Conditions (AGB) of Hermann Sewerin GmbH are not broadened by this information.
In addition to the warnings and other information in these Operating Instructions, always observe the generally applicable safety
and accident prevention regulations.
The manufacturer reserves the right to make technical changes.
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1.2

Purpose
SeCorr is a system used for correlation.
The SeCorr system can be used for:
●● Detecting leaks in water pipes
Note:
All descriptions in these operating instructions refer to the system
as delivered (factory settings). The operating instructions apply
to the C 200 receiver with firmware version 2.x and higher. The
manufacturer reserves the right to make changes.

1.3

Intended use
The SeCorr system is intended for professional industrial and
commercial use. The appropriate specialist knowledge is required to operate the system.
Note:
If necessary, learn more about the principles of the technology
before commencing practical work with the system.
The system must only be used for the applications specified in
section 1.2.
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1.4

General safety information
This product was manufactured in keeping with all binding legal
and safety regulations. It corresponds to the state of the art and
complies with conformity requirements. The product is safe to
operate when used in accordance with the instructions provided.
However, if you handle the product improperly or not as intended, the product may present a risk to persons and property. For
this reason, observe the following safety information without fail.
Risk of personal injury (health risk)
●● Handle the components carefully and safely both during transport and when working.
●● Proceed with extreme caution in the vicinity of electrical lines.
Hazards for the product and other property
●● Always handle the components carefully.
●● Do not drop the components.
●● Do not place the components in places where they are at risk
of falling.
●● The aerials of the C 200 receiver and RT 200 transmitter must
not be damaged.
−− Never bend, kink or cut the aerial.
−− Never carry the C 200 receiver by its aerial.
●● Before starting work, check that the components are in good
working order. Never use damaged or defective components.
●● Ensure that no dirt or moisture gets into the connections on
the components.
●● Always observe the permitted operating and storage temperatures.
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1.5

Radio communication
The SeCorr system uses the following data transmission technologies:
●● Near-field radio
●● SDR (Sewerin Digital Radio)
Near-field radio
The transmitter and receiver communicate by near-field radio.
The RT 200 transmitter is classed as radio equipment according
to EU Directive 2014/53/EU. It may, therefore, be subject to some
use restrictions.
Note:
Users of the SeCorr system are responsible for ensuring compliance with local country regulations regarding the registration and
use of radio equipment. This applies even if there is an explicit
licence for a country.
You can find a list of the countries of the European Economic Area (EEA) where this equipment is licensed for use in section 6.7 on page 80.
Note:
Radio systems that use the same frequencies can interfere with
each other.
●● Switch off the transmitters when not in use.

SDR radio
Receivers and wireless headphones communicate by bidirectional SDR (SDR: Sewerin Digital Radio). SDR is only used when
listening to noises.
For more detailed information about the special features of this
radio connection, please refer to section 3.7.1 on page 42.
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SeCorr system

2.1

General information about the system
The SeCorr system works using the correlation method, whereby
measurements are taken at two fittings (e.g. slide gate, hydrant)
at the same time. Highly sensitive microphones record the noises at the fittings. The two microphones are each connected to a
radio transmitter. The radio transmitters transmit the signals to a
receiver – the correlator. The correlator determines the run time
difference between the signals, i.e. the time lag between the noises reaching the two measuring points. This is then used, together
with the pipe data, by the correlator to calculate the leak position.
The advantage of the correlation method is that the leak position
is determined independently of the hearing and experience of
the user.
The system features a function which can also locate leaks
acoustically if there is no suitable technology available specifically for pinpointing or prelocation.

2.2

System components

2.2.1

Overview
SeCorr is a modular system. The main system components are
as follows:
●● C 200 receiver (correlator)
●● 2 RT 200 transmitters (1 pair)
−− Transmitter 1 with blue flag
−− Transmitter 2 with orange flag
●● 2 microphones, e.g.:
−− UM 200 universal microphone
OR
−− HY 200 hydrophone
One microphone is required for each RT 200 transmitter. The
same type of microphone must always be used for the two
transmitters.
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●● F8 wireless headphones (optional)
●● AC 200 SK 4 case
The system can be transported and stored in the case. The
batteries for the components C 200, RT 200 and F8 can be simultaneously charged in the case using the AC/DC adapter L.
Accessories can be added to the system at any time.
Note:
Information about F8 wireless headphones can be found in the
relevant operating instructions.

2.2.2

C 200 receiver
The C 200 receiver receives data from the RT 200 transmitter.
The receiver calculates the leak position from the run time difference between the signals of the two receivers.
The C 200 receiver is also known as a correlator.

2.2.2.1 Setup
Overviews with the names of all the parts of the receiver can be
found inside the front cover (fig. 1 and fig. 2).
Its symmetrical housing means that it can be operated by both
right-handed and left-handed users with ease.
Touch screen
The receiver features a touch screen. Certain areas of the touch
screen are touch-sensitive. Actions are performed by touching
these areas (buttons).
All of the buttons have a thick, dark grey outline.
Only your finger or a touch pen should be used to operate the
touch screen.
●● Always touch the buttons briefly without exerting too much
pressure.
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NOTICE! Risk of damage
The surface of the touch screen is sensitive.
●● Do not use any hard or sharp objects (e.g. pens) to operate
the screen.
●● Protect the touch screen against aggressive substances (e.g.
acidic or abrasive detergents).
An overview with the symbols that might appear on the touch
screen can be found in section 6.2 on page 75.
Light sensor
The light sensor analyses the ambient lighting conditions.
If the automatic brightness setting is enabled, the light sensor
always adjusts the brightness of the touch screen to the ambient
lighting conditions.
Information about the automatic brightness setting can be found
in section 4.4.1.3 on page 59.
ON/OFF key
The ON/OFF key has the following functions:
●● Switching the receiver on and off
●● Locking and unlocking the display
LED
The LED indicates the operating status.
Information about what the LED signals mean can be found in
section 6.3.1 on page 77.
Aerial
When using the receiver, the aerial must be pointing upwards
(fig. 6). It can be folded down for storage in the case.
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Fig. 6:

Receiver in its normal position of use
The aerial is pointing upwards.

Ports
The receiver features the following ports:
●● Charging socket
For charging the rechargeable battery.
●● Microphone socket
For connecting a microphone, e.g. UM 200 universal microphone.
●● USB port
For connecting to a computer.
Connectors
Carrying systems (Vario, lap belt), the triangle 200 carrying strap
or a hand loop can be attached to the connectors.
The connectors are parts of the quick-release fasteners.
2.2.2.2 Carrying the system
The receiver is usually carried in front of the body so that the user
looks diagonally down at the touch screen.
SEWERIN recommends: Use a carrying system for locating operations. The carrying system prevents you from tiring during
work. It also reduces the possibility of radio interference. Radio interference can occur if the user accidentally covers certain
components in the receiver.
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2.2.2.3 Automatic power off
The power supply to the receiver is designed in such a way that
a fully charged battery will allow one full day‘s work without interruption. However, it is still recommended to conserve energy
whilst working.
The receiver therefore offers the following automatic power-off
options:
●● Switching off the device
The receiver switches off if it is not operated for a specified
period of time. It must be switched back on again when you
want to continue work.
●● Switching off the backlight
The receiver backlight switches off if it is not operated for a
specified period of time. The receiver remains switched on.
If and when the automatic power off is activated depends on the
settings (Device menu > General > Switch off device or Switch
off backlight).
2.2.2.4 Main view
The touch screen of the receiver displays the main view when
the system is ready for use.

Fig. 7:

Main view
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Fig. 8:

Results display (detail of main view)

The following is shown in the centre of the main view (fig. 8):
●● Leak position
Distance of leak from transmitter 1 and transmitter 2
●● Quality of peak
●● Duration of measurement
The main view also contains the following buttons:
●● Measurement
●● File
●● Transmitter
●● Pipe sections
●● Filter
●● Settings
These buttons can be used to open submenus. Most of the buttons also display information. The information displayed depends
on the situation.
Measurement
The Measurement button is divided into different sections. The
appearance of the Measurement button depends on what the
program is doing (fig. 9).
●● Start measurement button
OR
Stop measurement button
●● Reset button
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Fig. 9:

Measurement button at various stages of the program
Top image:		
A measurement can be started.
Centre image:
A measurement can be stopped.
Bottom image:
The calculation data must be reset
before a measurement can be started.

For more detailed information on performing measurements,
please refer to section 3.4 on page 25.
File
The File menu is opened by pressing the File button. The following actions can be performed in this menu:
●● Save measurement
●● Load saved measurement
●● Delete saved measurement

Fig. 10: File button

For information about saving, loading and deleting measurements, please refer to section 3.4.3 on page 27.
Transmitter
The Transmitter button displays the following information:
●● Current noise level of the transmitters
−− Left:

Transmitter 1 (blue)

−− Right:

Transmitter 2 (orange)
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Fig. 11: Transmitter button

The Transmitter menu is opened by pressing the Transmitter
button. The following settings can be made in this menu:
●● Transmitters from which noises can be heard through headphones
●● Volume of noise on headphones
Information about the two transmitters is also displayed.
For more detailed information about the Transmitter menu and
listening to noises, please refer to section 3.7 on page 42.
Pipe sections
The Pipe sections button displays the following information:
●● Total length of measuring section
●● Number and length of pipe sections
●● Marker
Indicates the leak position in the pipe section concerned.
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Fig. 12: Pipe sections button, here: Measuring section with three pipe
sections
Top image:		
Before starting a measurement.
Bottom image:
After starting/stopping a measurement

The Pipe sections menu is opened by pressing the Pipe sections button. The following settings can be made in this menu:
●● Number of pipe sections in a measuring section
●● Pipe data for every pipe section
−− Material
−− Diameter
−− Length
−− Sound velocity
For more detailed information about configuring the pipe sections, please refer to section 3.3 on page 22.
Filter
The Filter button displays the following information:
●● Correlation curve
●● Marker
Corresponds to the leak position.
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Fig. 13: Filter button

The Filter menu is opened using the Filter button. This menu
allows you to optimise the correlation result using filters.
For more detailed information on filters, please refer to section 3.5 on page 31.
Settings
The Settings button displays the following information:
●● Interference suppression setting
●● Number of calculations
●● Connected components and information about the charge of
the relevant batteries

Fig. 14: Settings button
1 Interference suppression, 2 Calculations
3 Components and charge of relevant batteries

The Settings menu is opened using the Settings button. The
following settings can be adjusted in this menu:
●● Measurement
●● Device
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For more detailed information on the Settings menu, please refer
to section 4 on page 49.
2.2.2.5 How interference suppression works
The interference suppression function allows you to exclude noises from the correlation that may have a negative effect on the
result (e.g. sound interference from passing vehicles).
How interference suppression works depends on the settings
(Measurement menu > General).

Fig. 15: Interference suppression (detail of Settings button)
Left image: Interference suppression on
Right image: Interference suppression off

Whenever interference suppression is active during a measurement, the interference suppression symbol turns red on the Settings button.

Fig. 16: Interference suppression active

2.2.3

RT 200 transmitter
The RT 200 transmitters send the measurement data from the
microphones to the C 200 receiver. The transmitters are always
used in pairs.
The two transmitters are marked with a number and a colour to
make them distinct.
●● Transmitter 1 with blue flag
●● Transmitter 2 with orange flag
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Note:
The C 200 receiver uses the same number and colour assignment, e.g. when displaying results.

2.2.3.1 Setup
Overviews with the names of all the parts of the transmitter can
be found inside the front cover (fig. 3 to fig. 5).
Ports
The transmitter features the following ports:
●● Charging socket
For charging the rechargeable battery.
●● Microphone socket
For connecting a microphone.
Filter key
Note:
The SeCorr system has filter options for various purposes. An
overview of these can be found in section 2.4 on page 20.
The bandpass can be adjusted using the filter key. A bandpass is
a filter that only allows signals through from a certain frequency
range.
This function can be used to adjust the noise transmission to the
current situation. For example, when performing correlation on
plastic pipes, the quality of the measurement can be improved if
necessary using the low pass setting.
The options are:
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●● Low pass
f

●● Default
●● High pass

Allows all signals below a limit frequency through. Blocks any signals
above the limit frequency.
Allows all signals through.

f

f

Allows all signals above a limit frequency through. Blocks signals below the limit frequency.

There is an LED next to each symbol. The LED of the set bandpass turns green.
The RT 200 always switches to the Default setting when switched
on.
Light key
The light key is used to switch the light source of the UM 200
universal microphone on and off.
LED
The LED indicates the operating status.
Information about what the LED signals mean can be found in
section 3.2 on page 22.
Aerial
There is a knob at the top end of the aerial for convenient carrying
of the transmitter.
2.2.3.2 Switching the transmitter on and off
Switching on
The transmitter automatically switches on as soon as a microphone is connected.
Switching off
The transmitter automatically switches off as soon as the microphone is disconnected from the transmitter.
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For more detailed information about the plug connection between
the microphone and the transmitter, please refer to section 2.5
on page 20.
2.2.4

Microphones
The microphones record noises at the measurement locations.
This data is then sent to the transmitters via cable.
The system can be used with different microphones. One microphone is required for each RT 200 transmitter. The same type of
microphone must always be used for the two transmitters.

2.2.4.1 UM 200 universal microphone
The UM 200 is a highly sensitive microphone for picking up structure-borne noise.
The UM 200 is connected directly to the RT 200 receiver with a
cable.
Accessories can be attached to the UM 200. The right accessories can be used to secure the microphone at various measurement locations.
The microphone features a light which can be used to illuminate
the measurement location (torch function).

A

CAUTION! Risk of glare
The light source comprises two powerful LEDs.
●● Do not look directly into the light.
●● Never shine the light into the eyes of another person.

Contact adapter
The contact adapter is an accessory with which the microphone
can be attached directly to the measuring point.
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A

CAUTION!
Danger when using the contact adapter
The contact adapter contains a strong magnet.
●● Keep the contact adapter away from magnetic storage
media (e.g. hard drives, credit cards) and medical devices (e.g. pacemakers, insulin pumps).

The contact adapter is supplied with a short-circuit disc.
●● Remove the short-circuit disc before using the contact adapter
for the first time.
2.2.4.2 HY 200 hydrophone
The HY 200 hydrophone records noises directly from the water
column.

A

CAUTION! Risk of contamination
The HY 200 is designed for use in drinking water networks.
●● Always disinfect the HY 200 before use.

2.3

Switching on and off

2.3.1

Receiver
Switching on
●● Press the on/off key until the LED turns green.
Switching off
1. Briefly press the ON/OFF key. The Switch off dialog will appear.
2. Tap Switch off device. The receiver switches off.
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2.3.2

Transmitter
Switching on
The transmitter automatically switches on as soon as a microphone is connected.
Switching off
The transmitter automatically switches off as soon as the microphone is disconnected from the transmitter.
For more detailed information about the plug connection between
the microphone and the transmitter, please refer to section 2.5
on page 20.

2.4

Filter options (overview)
Filters can be used both on the transmitter and the receiver. Filters are used for different purposes.
●● RT 200 transmitter
−− The bandpass can be adjusted using the filter key (section 2.2.3.1 on page 16).
●● C 200 receiver
−− The correlation result can be optimised using filters (section 3.5 on page 31).
−− A blocking filter can be used to minimise the effects of current-carrying electrical lines on the noise (section 4.3.1.4 on
page 54).
−− Date filters can be used to search for specific measurements in the list of saved measurements (section 3.4.3.1
on page 28).

2.5

Plug connection between microphone and RT 200
transmitter
The plug connection is coded. For clarity, the following are each
marked with a red dot:
●● Plug on microphone cable
●● Microphone socket on RT 200 transmitter
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Connecting the microphone
●● Align the two red dots with each other. The plug can be inserted
into the microphone socket.
Disconnecting
●● Pull back the cover on the microphone plug. This will release
the connection. The microphone cable can now be removed.
2.6

Power supply to the components
The following components are powered by a special, inbuilt rechargeable lithium-ion battery.
●● C 200 receiver
●● RT 200 transmitter
The F8 wireless headphones come with a rechargeable NiMh
battery.
For information on charging the batteries, please refer to section 5.1 on page 62.
NOTICE! Risk of damage when changing lithium-ion batteries
The battery compartments of the components contain parts that
could get damaged when the batteries are being replaced.
●● Only SEWERIN service personnel or other authorised specialists may replace rechargeable lithium-ion batteries.

A

WARNING! Risk of explosion due to short-circuit
Faulty lithium-ion rechargeable batteries can explode due
to internal short-circuit.
●● Components containing a faulty lithium-ion battery must
not be shipped.
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3

Using the system

3.1

Preparing the system
Two suitable measurement locations must be found depending
on conditions on the ground. Suitable measurement locations
include, for example, fittings or the pipe itself.
1. Attach a microphone to each of the measurement locations.
−− The same microphone type must be used at the two measurement locations.
2. Connect each of the microphones to an RT 200. The RT 200
will switch on automatically.
3. Switch on the C 200 receiver. The system is ready for use.

3.2

Measurement steps (overview)
Once the system has been prepared, location can begin.
A measurement comprises the following steps:
1. Configuring the pipe sections

3.3

(section 3.3 on page 22)

2. Starting a measurement

(section 3.4.1 on page 26)

3. Stopping a measurement

(section 3.4.2 on page 27)

4. Selecting and adjusting filters
(optional)

(section 3.5.2 on page 34)

5. Saving a measurement
(optional)

(section 3.4.3 on page 27)

Configuring the pipe sections
A measuring section can comprise one or more pipe sections.
Each pipe section is characterised by its pipe data. New pipe
sections are automatically assigned values from the Pipe data
(Default).
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Note:
The quality of the correlation result depends greatly on the configuration of the pipe sections.
●● Make sure you configure the pipe sections completely and correctly in accordance with the conditions on the ground.
●● Adjust the settings before starting the measurement. Any
changes made after the start of a measurement will mean that
it will not be possible to continue the measurement afterwards.

The main view is open.
1. Tap the Pipe sections button. The Pipe sections menu will
appear.

Fig. 17: Pipe sections menu
Top:
Diagram of pipe sections, here: measuring section
with two pipe sections, 2nd pipe section selected
(highlighted blue)
Top right:
Add button
Centre:
Pipe data from the selected pipe section

2. Set the number of pipe sections (section 3.3.1).
3. Adjust the pipe data for every pipe section (section 3.3.2).
3.3.1

Setting the number of pipe sections
A measuring section consists of:
●● at least one pipe section
●● a maximum of five pipe sections

3 Using the system │ 23

3.3.1.1 Adding a pipe section
The first pipe section is set on transmitter 1.
●● Up to four more pipe sections can be added between the first
pipe section and transmitter 2.
●● New pipe sections are added to the right of the selected pipe
section.
The Pipe sections menu is open.
1. Tap on the pipe section beside which you want to add a new
pipe section. The pipe section will be highlighted in blue.
2. Tap on the Add button. A new pipe section will be added.
Note:
Adjust the pipe data for the new pipe section (section 3.3.2).
3. Apply the settings by pressing Confirm. The receiver will
switch back to the main view.
3.3.1.2 Deleting a pipe section
Pipe sections can be deleted.
The last remaining pipe section cannot be deleted. The pipe
data for it, however, can be reset to the default values by going
through the deletion process.
The Pipe sections menu is open.
1. Tap the pipe section to be deleted. The pipe section will be
highlighted in blue.
2. Tap the selected pipe section again. The pipe section will be
deleted without any further confirmation prompt.
3. Apply the settings by pressing Confirm. The receiver will
switch back to the main view.
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3.3.2

Adjusting the pipe data
Pipe sections are characterised by the following features:
●● Length of pipe
●● Diameter of pipe
●● Pipe material
●● Sound velocity in the pipe section
Adjoining pipe sections in a measuring section can have different
pipe data.
New pipe sections are automatically assigned values from the
Pipe data (Default). The values must then be adjusted according
to the conditions on the ground.
For more detailed information about the selection options and
value ranges, please refer to section 4.3.3 on page 56.
The Pipe sections menu is open.
1. Tap the pipe section for which you want to adjust the pipe
data. The pipe section will be highlighted in blue.
2. Adjust the pipe data.
3. Apply the settings by pressing Confirm. The receiver will
switch back to the main view.
Note:
After a sound velocity measurement (section 3.6.3), the Sound
velocity symbol is displayed next to the numerical value in the
Pipe sections menu under Sound velocity.
If you manually adjust the preset sound velocity, the Manual symbol is displayed next to the numerical value in the Pipe sections
menu under Sound velocity.

3.4

Performing a measurement
Each measurement must be started manually and stopped at a
suitable time.
Once a measurement has been stopped, it can be saved, continued or repeated.
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3.4.1

Starting a measurement
Note:
The quality of the correlation result also depends on the general
noise level at the start of a measurement.
●● Wherever possible, try to start a measurement when there is
no loud sound interference in the background (e.g. no passing
vehicles, extraction from house connections).

The main view is open. The Start measurement button is visible (fig. 9, image above).
●● Tap the Start measurement button when the general noise
level is suitable. The measurement will start. The Stop measurement button will appear.
3.4.1.1 Starting the measurement after configuring pipe sections
Once the pipe sections have been configured, the calculation
data must be reset before a new measurement can be started.
The main view is open. The Start measurement button is not
visible (fig. 9, image below).
1. Tap the Reset button. The Start measurement button will
appear.
2. Tap the Start measurement button when the general noise
level is suitable. The measurement will start. The Stop measurement button will appear.
3.4.1.2 Continuing measurement
Measurements can be continued under the following conditions:
●● The measurement has been stopped.
●● The pipe sections have not been changed.
●● The calculation data has not been reset.
To continue the measurement, it must be restarted.
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●● Tap the Start measurement button when the general noise
level is suitable. The measurement will start. The Stop measurement button will appear.
3.4.1.3 Repeating a measurement
Measurements can be repeated under the following conditions:
●● The measurement has been stopped.
●● The pipe sections have not been changed.
To repeat a measurement, it must be restarted.
1. Tap the Reset button. The Start measurement button will
appear.
2. Tap the Start measurement button when the general noise
level is suitable. The measurement will start. The Stop measurement button will appear.
3.4.2

Stopping a measurement
Ongoing measurements can be stopped at any time.
In order to achieve a reliable result, SEWERIN recommends: Not
stopping the measurement until the marker, leak position and
quality of the peak stop changing.
The main view is open. A measurement is ongoing.
●● Tap the Stop measurement button. The measurement will
stop. The Start measurement button will appear.
Stopped measurements can be saved or continued.

3.4.3

Saving a measurement
Measurements can be saved. Approximately 70 measurements
can be saved.
A message will appear when the memory is full. Measurements
can be deleted from the memory to free up space. For information about deleting saved measurements, please refer to section 3.4.3.2 on page 30.
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Saved measurements are indicated by:
●● Date (day and time measurement was saved)
●● Optional: Comment
The main view is open. The measurement was stopped
1. Tap the File button. The File menu will appear.
2. Tap the Save button. The Comment menu appears.
3. Measurements can be saved with or without additional information.
●● Tap Confirm to save the measurement without additional
information.
OR
a) Enter a comment using the virtual keyboard.
The comment can be up to a maximum of 25 characters
long.
b) Tap Confirm to save the measurement with additional information.
The receiver will switch back to the main view.
3.4.3.1 Loading a saved measurement
Saved measurements can be loaded from the memory. Information about the measurement can also be displayed.
Note:
Only one measurement can be loaded at a time.

The main view is open.
1. Tap the File button. The File menu will appear.
2. Tap the Load button. The Load menu will appear.

28 │ 3 Using the system

Fig. 18: Load menu
Top left:
Filter by date button
Centre:
List of saved measurements

3. Tap the relevant measurement in the list. The measurement
will immediately appear in the main view.
Searching for saved measurements
Date filters can be set in the list of saved measurements to search
for specific measurements.
The following date filters are available:
●● Year
●● Year and month
The Load menu is open.
1. Tap the Filter by date button on the top left. The Filter by
date menu will appear.
2. Set the values for the search.
−− Left field: Year, right field: Month
−− Any means that no date filter will be set.
−− Only values that have been saved for the data are available
for the search.
Example:
Measurements were saved in 2017 and 2019. No measurements were saved in 2018. The filter criteria available for
selection are: Any, 2017, 2019.
3. Apply the filters by pressing Confirm. The receiver will switch
back to the Load menu.
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The list will show all the measurements that match the search
criteria. The date filter settings are displayed on the Filter by
date.

Fig. 19: Filter by date button
Left image: No date filter set
Right image: Date filter set (year: 2019, month: 01 January)

3.4.3.2 Deleting a saved measurement
Saved measurements can be deleted individually. To do this delete mode needs to be enabled.
NOTICE! Risk of data loss
In delete mode, measurements are deleted immediately without
further prompting.
●● Work with extreme care in delete mode.

The main view is open.
1. Tap the File button. The File menu will appear.
2. Tap the Load button. The Load menu will appear.
3. Tap the Clear button. Delete mode is enabled. The dot on the
Clear button turns red. The measurements in the list appear
in red.
4. Tap the measurement you want to delete in the list. The measurement will be deleted immediately without further prompting.

30 │ 3 Using the system

5. Finally, disable delete mode.
●● To do this, tap the Clear button again. Delete mode is disabled. The dot on the Clear button turns grey again. The
measurements in the list appear in black.
OR
●● Tap Back.
3.5

Optimising the correlation result using filters
Note:
The SeCorr system has filter options for various purposes. An
overview of these can be found in section 2.4 on page 20.
Filters can help optimise the correlation result and thus locate
leaks more reliably. Filters are set in the frequency graph.
A well-applied filter will have the following effect on the correlation curve:
●● Peaks will be displayed in higher quality, i.e. sharper, with
steeper sides, etc.
●● The peak of a potential leak noise will be accentuated compared to other noises (e.g. sound interference).
Aim of optimisation
The aim is to obtain the highest quality peak possible in the correlation curve.

3.5.1

Filter menu (overview)
The Filter menu displays the frequencies, correlation curve and
the result of the measurement as a graph.
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Fig. 20: Filter menu
Top:
Frequency graph
Centre:
Correlation curve
Bottom:
Result of measurement and quality of peak
Right (top to bottom):
Lower filter limit,
		
Current filter, here: Auto 1

Available filters
Various filters can be applied.
The options are:
●● Auto 1

Automatically calculated filter 1

●● Auto 2

Automatically calculated filter 2

●● Manual

Manually set filter

The symbol of the active filter is displayed on the Current filter
button.
Manually set filters are saved with a measurement.
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3.5.1.1 Frequency graph
The receiver displays the spectra of the noises in the frequency
graph.

Fig. 21: Frequency graph
1 Frequency axis, 2 Lower stopband, 3 Lower filter limit,
4 Graph of functions, 5 Passband,
6 Upper filter limit, 7 Upper stopband

In the settings you can specify whether to display one or two
functions (Measurement menu > Filter basis).
If two functions are displayed:
●● Areas in which the two functions overlap are shown in black.
●● If the values of one function are lower than the values of the
other function across the whole frequency range, you will only
be able to see the function with the higher values and the
overlap.
One filter is always set in the frequency graph. This filter can be
changed.
●● The filter currently applied will be shown on the Current filter
button.
●● The values of the filter limits will be specified on the Filter
limits buttons.
Dashes will be shown instead of digits if an automatic filter calculates the entire frequency range as the passband.
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3.5.1.2 Correlation curve
The run time difference between the signals of the two transmitters is displayed in the correlation curve.

Fig. 22: Correlation curve with marker (red rectangle)

The area around the highest peak of the curve is marked with a
red rectangle. This marker indicates the calculated leak position.
If a correlation curve shows several significant peaks, a plausibility check should be carried out (section 3.6).
3.5.1.3 Quality of peak
The sharper or clearer the peak, the better the quality. The quality
can be improved by setting filters.
The quality of a peak is rated by dots. The more black dots, the
higher the quality.

Fig. 23: Quality of peak
Left image: Very high quality
Right image: Poor quality

Note:
The quality of a peak does not correlate to the accuracy of the
calculated leak position.

3.5.2

Selecting and adjusting filters
One filter is always set in the frequency graph when the Filter
menu is opened. Whether an automatically calculated filter or a
manually set filter is applied first depends on the starting point.
Once the menu has been opened, you can switch between filters.
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Automatic filters are always recalculated when the Filter menu
is opened.
Opening the filter menu
The main view is open.
●● Tap the Filter button. The Filter menu appears (fig. 20).
Note:
Any ongoing measurements will be stopped when the Filter
menu is opened.

3.5.2.1 Selecting automatically calculated filters
Note:
Filters Auto 1 and Auto 2 are identical if the calculation algorithms on which they are based do not detect any differences.

The Filter menu is open.
●● Repeatedly tap the Current filter button. If the Auto 1 or
Auto 2 symbol appears, automatically calculated filter 1 or 2
will be applied.
3.5.2.2 Manually adjusting filters
There are two ways of manually adjusting the filter limits:
●● Quick adjustment
●● Exact adjustment
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Performing a quick filter adjustment
A quick adjustment involves resetting both filter limits.
The Filter menu is open.
1. Tap the frequency graph (fig. 21).
−− as accurately as possible.
The Filter menu will change its appearance (fig. 24). The first
filter limit is set.

Fig. 24: Filter menu: Quick filter adjustment

2. Tap the frequency graph a second time.
−− The higher of the two tapped frequency values will be assigned to the upper filter limit.
The Filter menu will return to its default view (fig. 20). The
second filter limit is set. The Manual symbol is visible on the
Current filter button.
Performing an exact filter adjustment
When performing an exact adjustment, the upper and lower filter
limits are set independently of each other. The filter limits can be
moved in very small increments.
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Fig. 25: Filter – Zoom menu: Exact filter adjustment
Left image: With the Upper filter limit, Lower filter limit (right)
and Zoom (centre) buttons
Right image: With the Confirm button

The Filter menu is open.
1. Tap the Filter limits button. The receiver will switch to the
Filter – Zoom menu (fig. 25, left image).
2. Reset the filter limit. Tap one of the Upper filter limit or Lower
filter limit buttons. The Filter – Zoom menu will change its
appearance (fig. 25, right image).
The filter limit stop range that can be adjusted is displayed
in orange.
●● Tap Zoom. The display changes immediately.
●● Tap the frequency graph to roughly set the filter limit.
●● Tap one of the Move buttons to define the filter limit exactly.
3. Apply the setting by pressing Confirm. The receiver will
switch back to the previous view.
4. If necessary, repeat all the steps for the other filter limit.
5. Tap Back. The receiver will return to the Filter menu. The
Manual symbol is visible on the Current filter button (see
fig. 26).

3 Using the system │ 37

Fig. 26: Filter menu: After manual adjustment, the Manual symbol appears under the Filter limits button.

3.5.2.3 Applying the filters (exiting the Filter menu)
The settings can be applied once the filter limits have been adjusted.
The Filter menu is open.
●● Tap Back. The filter settings will now be applied. The receiver
will switch back to the main view.
3.6

Plausibility check
The correlator cannot determine whether there is an actual leak
at a calculated position or whether the noise is interference (e.g.
open house connection).
This can pose a problem if the correlation curve shows more than
one significant peak. In such cases, we recommend checking the
plausibility of the correlation result.
The following options are available for checking the plausibility:
●● Moving the marker
●● Hide peak
●● Sound velocity measurement

3.6.1

Moving the marker
Correlation curves can show several significant peaks. The position of another noise source is calculated by moving the marker.
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The Filter menu is open.
1. Tap the correlation curve. The receiver will switch to the Correlation menu (fig. 27).
2. Place the marker on another peak. Tap the desired position
in the correlation curve.
3. Read the newly calculated position.
4. Check the conditions on the ground.
−− Is there another noise source at the calculated location?

Fig. 27: Correlation menu
Top:
Correlation curve
Below (from left): Show peak, Hide peak, Sound velocity buttons
Bottom:
Display of leak position and run time difference Δ t

5. Tap Back. The receiver will switch to the Filter menu. The
newly set marker is applied to the correlation curve.
3.6.2

Hide peak
Noise from sources of interference can overlap leak noise. The
peak of an interference noise can be faded out in a targeted
manner.
The Filter menu is open.
1. Tap the correlation curve. The receiver will switch to the Correlation menu (fig. 27).
2. Tap the Hide peak button.
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3. Select the area you want to hide.
a) Tap the correlation curve to set the first limit.
b) Tap the correlation curve again to set the second limit.
The hidden area is displayed in orange.
4. Tap Back. The settings are applied. The receiver will switch to
the Filter menu. The correlation curve shows the hidden area.
Hidden peaks can be shown again at any time.
●● Tap the Show peak button in the Correlation menu. The selected area is deleted. The selected peak is visible again.
3.6.3

Sound velocity measurement
The sound velocity depends to a large degree on the pipe data
(length, diameter, material). The receiver has default values for
the sound velocity which are used to calculate the leak position.
In practice, there may be deviations from the known or assumed
pipe data on a measuring section. These deviations can have
a significant effect on the accuracy of the measurement. This
applies in particular to leaks that are not located in the middle of
the measuring section. A sound velocity measurement is recommended in such cases.

.

Fig. 28: Sound velocity menu
Top:
Correlation curve
Below (from left): Start measurement, Reset, Outside 1,
Between the transmitters, Outside 2 buttons
Bottom:
Measured sound velocity, number of calculations
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3.6.3.1 Artificial leak outside of the measuring section
In the ideal case, it is possible to generate an artificial leak outside of the measuring section.
1. Generate an artificial leak (e.g. open hydrant) outside of the
measuring section.
Open the Filter menu on the device.
2. Tap the correlation curve. The Correlation menu appears.
3. Tap the Sound velocity button. The Sound velocity menu
will appear.
4. Specify whether the artificial leak is outside transmitter 1 or
outside transmitter 2. Tap the corresponding button.
5. Tap the Start measurement button. The measurement will
start. The Stop measurement button will appear.
6. Stop the measurement when the current value for the measured sound velocity has stabilised.
7. Apply the measured sound velocity by pressing Confirm.
The sound velocity measurement is complete. The receiver will switch back to the Correlation menu. The measured
sound velocity is applied to the current measurement.
3.6.3.2 Artificial leak within the measuring section
In certain cases it is not possible to generate an artificial leak
outside of the measuring section. The sound velocity can also be
measured using an artificial leak within the measuring section.
1. Open the Sound velocity menu.
2. Tap the Between the transmitters button. The dialog Distance (from 1) [m] appears.
3. Enter the distance of the artificial leak from transmitter 1.
4. Confirm the entry. The receiver will switch back to the Sound
velocity menu.
5. Tap the Start measurement button. The measurement will
start. The Stop measurement button will appear.
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6. Stop the measurement when the current value for the measured sound velocity has stabilised.
7. Apply the measured sound velocity by pressing Confirm.
The sound velocity measurement is complete. The receiver will switch back to the Correlation menu. The measured
sound velocity is applied to the current measurement.
3.7

Listening to noises
Note:
F8 wireless headphones are required for listening to noises.

3.7.1

Information about the radio connection during listening
The C 200 receiver and F8 wireless headphones communicate
by bidirectional SDR (SDR: Sewerin Digital Radio).
SDR transmits uncompressed signals in real time. Radio interference can, therefore, cause a short clicking noise in the headphones.
SDR uses the same frequency ranges as, for example, WLAN
or Bluetooth. In rare cases, SDR can, therefore, be affected by
other radio connections.
These effects can be minimised by the following measures:
●● Avoid drops in the SDR radio connection caused by obstructions, e.g. your own body. Carry the receiver in such a way
that the transmission path to the headphones is not obscured.
●● If you are carrying electronic devices that use WLAN and Bluetooth directly on your body: Disable the WLAN and Bluetooth
function if necessary.

3.7.2

Transmitter menu (overview)
The Transmitter menu displays information about the transmitters connected by radio.
The following noise settings can be adjusted:
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●● Volume on the headphones
●● Transmitter selection
The microphone function can be opened if a microphone is connected to the receiver.

Fig. 29: Transmitter menu without a connected transmitter

Fig. 30: Transmitter menu with connected transmitters
Top:
Volume
Centre:
Transmitter selection
Left/right:
Information about transmitter 1/2

Information about the transmitters
The following information appears as soon as an RT 200 transmitter is connected:
●● Strength of radio signal at receiver
●● Current noise level at transmitter
●● Battery charge
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●● Bandpass setting
●● Satellite reception

Fig. 31: Information about the transmitter, here: Transmitter 1
From left to right: Radio signal, noise level, rechargeable battery,
		
bandpass, satellite reception

Note:
The information is not constantly updated as radio transmission
of the noise takes precedence. It can sometimes take up to 20s
for changes to be displayed.

3.7.3

Adjusting the volume
The volume determines how loudly the noises are played back
through the headphones.

A

CAUTION! Health hazard
Excessive noise can damage hearing and lead to irreversible damage to health.
●● Always adjust the volume to the current situation.
●● Choose as low a volume as possible.

The main view is open.
1. Tap the Transmitter button. The Transmitter menu will appear.
2. Adjust the volume. To do this, tap on either:
−− the volume symbols
−− in the area between the two volume symbols
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Fig. 32: Adjusting the volume

3. Apply the settings by pressing Confirm. The receiver will
switch back to the main view.
The settings are stored until they are next adjusted.
3.7.4

Selecting a transmitter
The noises from the two measuring points can be listened to
together or separately.
The options are:
●● Noises from transmitters 1 and 2
●● Noises from transmitter 1
●● Noises from transmitter 2
●● No noise

The main view is open.
1. Tap the Transmitter button. The Transmitter menu will appear.
2. Tap the relevant transmitter selection. The setting is applied
immediately.
The setting is stored until it is next adjusted.
3.8

Microphone function for acoustic leak detection
The microphone function is an extra function on the C 200 receiver.
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The microphone function can be used to listen to noises directly at a measurement location. It can be used when there is no
suitable technology available specifically for pinpointing or prelocation.
Note:
The microphone function cannot be used for correlation.
The following system components are required for acoustic leak
detection:
●● C 200 receiver
●● Microphone, e.g. UM 200 universal microphone
●● F8 wireless headphones
3.8.1

Microphone menu (overview)
A measurement to listen to noises can be performed in the Microphone menu. The results of the measurement are displayed
in a graph and as numerical values.
Note:
The Microphone menu can only be opened when a microphone
is connected to the receiver.

Fig. 33: Microphone menu
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Fig. 34: Display of measurement values (detail of Microphone menu)
1 Current minimum noise level
2 Current noise level
3 Previous minimum noise level

The following measurement values are displayed (fig. 34):
●● Current noise level
●● Current minimum noise level
●● Previous minimum noise level
The Microphone menu also contains the following buttons:
●● Volume
●● Light
●● Listen to microphone
●● Turn off noise
The volume for the microphone function (Microphone menu) is
independent of the volume for listening to noises (Transmitter
menu). The volume must be set separately in the two menus. The
setting procedure is identical.
The Light key can be used to switch the microphone’s light
source on and off.
3.8.2

Performing a noise measurement
The current noise level is always displayed in the Microphone
menu. However, the noises can only be heard once a measurement has started.
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The receiver is switched on. The main view is open.
1. Connect a microphone (e.g. UM 200) to the microphone socket on the receiver.
2. Attach the microphone to a suitable measurement location.
3. Tap the Transmitter button. The Transmitter menu will appear. The Microphone button can be seen at the bottom right.
Which microphone symbol appears on the Microphone button depends on the microphone connected.
4. Tap the Microphone button. The Microphone menu will appear.
5. Tap the Listen to microphone button to start a measurement.
6. Adjust the volume to the current situation.
−− Proceed as explained in section 3.7.3 on page 44.
−− Please note the health hazard warning in the same section.
7. Tap the Switch noise off button when you want to stop the
measurement.
Exiting the Microphone menu
●● To return to the Transmitter menu, tap the Transmitter button.
●● To return to the main view, tap Back.
3.9

Locking and unlocking the display
The display can be locked against unintentional operation.
Locking
1. Briefly press the ON/OFF key. The receiver switches to the
Switching off menu for 3 seconds.
2. Tap Lock display. The display switches off immediately.
Unlocking
●● Briefly press the ON/OFF key again. The receiver displays
the Switching off menu. The display changes to the last view
shown after 3 seconds.
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4

Settings

4.1

Overview
All settings are managed using the C 200 receiver. The settings
can be changed at any time. The following menus are available:
●● Measurement
●● Device

4.2

Setting actions
The settings in the Measurement and Device menus are implemented as follows:
●● Select
●● Enable/disable
●● Set value

Fig. 35: Menu (sample diagram)
Very top:
Menu item with selected settings
Below:
Menu items with enabled/disabled settings
Bottom:
Menu items with set values

Menu items in which settings can be selected or values set are
indicated by the next symbol.
Menu items in which settings can be enabled/disabled are
marked with a check box (dot).
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4.2.1

Selecting

Fig. 36: Selecting a setting (sample diagram)
Top:
Setting selected
Bottom:
Setting not selected

Selected settings are indicated by the tick symbol.
1. In one of the menus, tap on the menu item for which you wish
to change the setting.
A sub-menu will appear.
2. Tap the relevant setting.
The setting is applied immediately without further confirmation. The receiver goes back up a menu level.
The selected setting is displayed in the higher menu level.
4.2.2

Enabling/disabling

Fig. 37: Enabling/disabling a setting (sample diagram)
Top:
Setting enabled
Bottom:
Setting disabled

Enabled settings are indicated by a green check box. Disabled
settings have a grey check box.
●● In one of the menus, tap on the menu item you wish to enable
or disable.
The setting is applied and displayed immediately without further confirmation.
4.2.3

Setting a value
Values are set either via a picklist or a numeric keypad.
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Picklist

Fig. 38: Picklist

Values are set using the arrow keys.
1. Tap an arrow key.
−− The up key increases the value.
−− The down key decreases the value.
2. Apply the settings by pressing Confirm.
The receiver goes back up a menu level.
Numeric keypad

Fig. 39: Numeric keypad

1. Tap the relevant number keys. The selected numbers will be
displayed via the numeric keypad.
2. Apply the value by pressing Confirm.
The value is rounded up or down if it is outside the value range
or has an invalid number of decimal places.
The receiver goes back up a menu level.
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4.3

Settings in the Measurement menu
The settings in the Measurement menu apply to the measurements.
General
Units

>

Metric
Anglo-American

Interference suppression

>

high
low
Off

Correlation curve

>

Positive
Positive & negative

Blocking filter

>

60 Hz
50 Hz
Off

>

blue
red
Off

Cross spectrum

>

blue
red
Off

Spectrum 1

>

blue
red
Off

Spectrum 2

>

blue
red
Off

Sound velocity

>

blue
red
Off

Pipe data (Default)
Length

>

…

Material

>

AC
Copper
…

Diameter

>

…

Sound velocity

>

…

Filter basis
Coherence

Fig. 40: Measurement menu
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The main view is open.
1. Tap the Settings button. The Settings menu appears.
2. Tap the Measurement button. The Measurement menu appears.
3. Adjust the settings as required.
The Measurement menu is divided into three views General,
Filter basis and Pipe data (Default).
Switch between the views using the Scroll buttons.
The settings options are explained in the next sections.
4. Finally, tap Back. The Settings menu appears.
5. Tap Back again to return to the main view.
4.3.1

General

4.3.1.1 Units
Different units can be used for specifying the pipe data.
The options are:
●● Metric
Length specified in metres (m) and diameter specified in millimetres (mm).
●● Anglo-American
Length specified in feet (ft.) and diameter specified in inches
(in.).
4.3.1.2 Interference suppression
Excessive noise can be suppressed to varying degrees
The options are:
●● On
Interference suppression is enabled. Some slightly quieter
noises may be excluded from the correlation.
●● Off
Interference suppression is disabled.
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4.3.1.3 Correlation curve
The correlation curve can be displayed in different ways.
The options are:
●● Positive
Displays the magnitude of the positive and negative values.
The correlation curve is above the x-axis.
●● Positive and negative
Displays both positive and negative values. The correlation
curve oscillates around the x-axis.
4.3.1.4 Blocking filter
The blocking filter is an electronic filter which filters out the mains
frequency of the power supply. This minimises the impact of current-carrying electrical lines on the noise.
The options are:
●● 60 Hz | 50 Hz
Mains frequency that can be selected.
●● Off
The blocking filter is disabled.
4.3.2

Filter basis
The noises can be displayed as a graph based on different functions in the Filter menu.
The options are:
●● Coherence
●● Cross spectrum
●● Spectrum 1
●● Spectrum 2
●● Sound velocity
Up to a maximum of two functions can be displayed at the same
time.
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4.3.2.1 Coherence
Coherence of noises transmitted by transmitters 1 and 2 to the
receiver.
The options are:
●● Blue | Red
Colour that can be selected for the graph.
●● Off
The function is not displayed.
4.3.2.2 Cross spectrum
Cross power spectrum of noises transmitted from transmitters 1
and 2 to the receiver.
The options are:
●● Blue | Red
Colour that can be selected for the graph.
●● Off
The function is not displayed.
4.3.2.3 Spectrum 1 or Spectrum 2
Auto-power spectrum of the noises transmitted from transmitter
1 or transmitter 2 to the receiver.
The options are:
●● Blue | Red
Colour that can be selected for the graph.
●● Off
The function is not displayed.
4.3.2.4 Sound velocity
The options are:
●● Blue | Red
Colour that can be selected for the graph.
●● Off
The function is not displayed.
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4.3.3

Pipe data (Default)
The default values, which are automatically assigned to each
new pipe section created, are set in the Pipe data (Default) view.
SEWERIN recommends: When selecting default settings, choose
typical values that commonly occur in your everyday work. For
example, if you primarily work on cast iron pipes, set the material
to cast iron.

4.3.3.1 Length
Indicates the length of a pipe section.
●● Value range: 0.5 m – 3000 m
●● Decimal places:

1

4.3.3.2 Material
Indicates the material of the pipe in the pipe section.
There is a wide range of materials available for selection.
4.3.3.3 Diameter
Indicates the diameter of the pipe in the pipe section.
●● Value range: 10 mm – 3000 mm
●● Decimal places:

None

4.3.3.4 Sound velocity
The sound velocity is automatically calculated by the device from
the diameter and the pipe material.
The calculated value can be changed. This change is saved temporarily. However, as soon as other settings are selected for the
diameter or the material, the sound velocity is recalculated.
●● Value range: 220 m/s – 2000 m/s
●● Decimal places:
4.4

None

Settings in the Device menu
The settings in the Device menu apply to the receiver.
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General
Switch off device

>

30 min
1h
3h
Off

Switch off backlight

>

30 s
1 min
15 min
30 min
Off

Automatic brightness

O

Brightness

>

…

Time/Date
Time
Date

>
>

…
…

Region
Date format

>

DD.MM.YY
YYYY-MM-DD
MM-DD-YYYY

Time format

>

12 h
24 h

Language

>

…
English
…

Service
Information
Calibration

Fig. 41: Device menu

The main view is open.
1. Tap the Settings button. The Settings menu appears.
2. Tap the Device button. The Device menu appears.
3. Adjust the settings as required.
The Device menu is divided into the four views General,
Time/Date, Region and Service.
−− Switch between the views using the Scroll buttons.
The settings options are explained in the next sections.
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4. Finally, tap Back. The Device menu appears.
5. Tap Back again to return to the main view.
4.4.1

General

4.4.1.1 Switching off the device
The receiver can switch off automatically if it is not operated for
a specified period of time.
Note:
This function helps save energy. It means that the receiver can
be used for longer without being recharged.
The options are:
●● 30 min | 1 h | 3 h
Duration that can be selected.
●● Off
The receiver does not switch itself off.
4.4.1.2 Switching off the backlight
The touch screen backlight can switch off automatically if it is
not operated for a specified period of time. The receiver remains
switched on.
Note:
This function helps save energy. It means that the receiver can
be used for longer without being recharged.
The options are:
●● 30 s | 1 min | 15 min | 30 min
Duration that can be selected.
●● Off
The backlight does not switch itself off.
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4.4.1.3 Automatic brightness
The brightness of the touch screen can automatically adjust to
the ambient lighting conditions thanks to the light sensor. This
means that the touch screen is clearly legible in every situation.
This function can be enabled or disabled.
●● When this function is disabled, you can set the brightness manually.
4.4.1.4 Brightness
Note:
Brightness only appears in the menu when the Automatic
brightness function is disabled.
When the Automatic brightness function is disabled, a permanent value can be set for the brightness of the touch screen.
4.4.2

Time/Date

4.4.2.1 Time
The receiver features an internal clock. The time is used to identify the measurements.
Note:
The format of the time can be set under Time format in the
menu.

4.4.2.2 Date
The date is used to identify the measurements.
Note:
The format of the date can be set under Date format in the menu.

4 Settings │ 59

4.4.3

Region

4.4.3.1 Date format
The date can be written in various ways. The options are:
●● DD.MM.YY
●● YYYY-MM-DD
●● MM-DD-YYYY
The letters refer to the following:
D: day
M: month
Y: Year
4.4.3.2 Time format
The time can be written in various ways.
The options are:
●● 12 h
12 hour clock
●● 24 h
24 hour clock
4.4.3.3 Language
The text on the user interface can be displayed in various languages.
There is a range of languages to choose from.
4.4.4

Service

4.4.4.1 Information
The relevant current technical information is stored in each receiver.
The following information will be displayed:
●● Firmware version number
●● Hardware version number
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4.4.4.2 Calibration
The touch screen can be calibrated by the user.
For more detailed information on calibration, please refer to section 5.3 on page 67.
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5

Maintenance

5.1

Charging the batteries
The batteries for the following components must be recharged
when necessary:
●● C 200 receiver (lithium-ion rechargeable battery)
●● RT 200 transmitter (lithium-ion rechargeable battery)
●● F8 wireless headphones (NiMH rechargeable battery)
The typical charging time is less than 7.5 hours. The batteries
are protected against overcharging. The components can, therefore, remain connected to the power supply after they are fully
charged.
Always observe the permitted temperature range during charging. If the temperature falls below or exceeds the limit values,
charging stops until the temperature returns to within the permitted range.
There are two ways of charging the components:
●● All components at the same time in the AC 200 SK 4 case
●● Each component individually using the AC/DC adapter or vehicle cable

5.1.1

Charging the batteries in the case
The batteries of the components can all be charged simultaneously in the AC 200 SK 4 case. The case is connected to the
power supply using AC/DC adapter L or vehicle cable L.
The AC/DC adapter and the vehicle cable are available to buy
as accessories.
The connection cable for the components can be found in the
case. There is a connection socket on the outside of the case for
connecting to the power supply.
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Fig. 42: AC 200 SK 4 case
White circles: Connection cable
Black arrow: Connection socket (on the outside)

1. Place the components in the dedicated spaces in the case.
2. Connect the components using the connection cables.
3. Connect the case to the power supply using the AC/DC adapter L or vehicle cable L. Charging starts automatically.
After less than 7.5 hours the charging process is complete.
5.1.2

Charging batteries using the AC/DC adapter or vehicle
cable
The components are connected directly to the power supply for
charging using AC/DC adapter M4 or vehicle cable M4. Each
component is charged individually.
The AC/DC adapter and the vehicle cable are available to buy
as accessories.
When the battery is fully charged, the LED on the C 200 receiver
and RT 200 transmitters emits a double flash (green).
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5.2

Handling faulty lithium-ion rechargeable batteries
Lithium-ion batteries are always classed as dangerous goods for
transport purposes.
The transportation of faulty lithium-ion batteries is only permitted under certain conditions (e.g. must not be transported as air
freight). Where transportation is permitted (e.g. by road or rail),
it is subject to strict regulations. Faulty lithium-ion batteries must,
therefore, always be removed from components before shipping.
Transportation by road or rail must occur in compliance with the
current applicable version of the ADR regulations 1.
NOTICE! Risk of damage when removing lithium-ion rechargeable batteries
When opening the housing, the components can be damaged
mechanically or by electrostatic discharge.
●● Lithium-ion batteries must only be removed if there is reasonable suspicion that they might be faulty.
●● Only SEWERIN Service personnel or an authorised specialist
may replace rechargeable batteries.

5.2.1

Identifying faulty batteries
A lithium-ion battery is considered to be faulty if one of the following criteria applies2:
●● Housing damaged or badly deformed
●● Liquid leaking from battery
●● Smell of gas from battery
●● Rise in temperature with the receiver switched off (more than
hand-hot)
●● Plastic parts melted or deformed
●● Connection leads melted

1

2

French abbreviation for: Accord européen relatif au transport international des marchandises dangereuses par route, Engl.: European Agreement
concerning the International Carriage of Dangerous Goods by Road
According to: EPTA – European Power Tool Association
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5.2.2

Removing the batteries from the C 200 receiver
NOTICE! Risk of damage
There are parts in the battery compartment of the receiver which
can be damaged mechanically or by electrostatic discharge when
removing the batteries.
●● Always read section 5.2 and section 5.2.1.
●● Avoid electrostatic discharges at all costs, e.g. by using an
ESD workstation.

Fig. 43: Back of the C 200 receiver
White circles: Screws of the battery compartment cover

The batteries are in the battery compartment. The battery compartment is sealed with the battery compartment cover.
The receiver must be switched off.
1. Undo the four screws securing the battery compartment cover.
2. Lift off the battery compartment cover with extreme care.
NOTICE! Risk of damage
There is an aerial in the battery compartment cover. That is why
the battery compartment cover has an electrical connection (cable) from the inside into the device interior.
●● Please ensure that the cable does not get severed.
●● Never touch the solder joint on the inside of the battery compartment cover.
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3. Disconnect the electrical supply to the faulty battery by pulling
off the white plug.
Never sever the cable.
4. Remove the battery.
5. Screw the battery compartment cover back on.
5.2.3

Removing the battery from the RT 200 transmitter
The battery is located inside the device.
NOTICE! Risk of damage
When opening the housing, the transmitter can be damaged mechanically or by electrostatic discharge.
●● It is essential to read section 5.2 and section 5.2.1 before removing the battery.
●● Avoid electrostatic discharges at all costs, e.g. by using an
ESD workstation.

There should be no microphone connected to the transmitter.
1. Undo the four screws on the bottom section of the housing.
2. Carefully lift off the bottom section of the housing.
The top section and the bottom section of the housing are
connected by means of the cable from the battery to the circuit board.
3. Disconnect the electrical supply to the faulty battery by unplugging the white connector on the circuit board.
Do not under any circumstances rip out the cable.
4. The battery is fixed in place in the bottom section of the housing by means of a retaining plate. Loosen the three screws
on the retaining plate.
5. Remove the battery.
6. Screw down the retaining plate again.
7. Screw the bottom section of the housing to the top section
again.
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5.3

Calibrating the touch screen
The touch screen of the C 200 receiver is calibrated when it
leaves the factory. If the touch screen responds incorrectly when
operated, it can be recalibrated.
Calibration involves two stages, which occur automatically in succession. Firstly the areas are reset. Then the reset areas need
to be confirmed.
Note:
If the calibration process is interrupted, the touch screen may be
so misaligned that it cannot be used.
●● Never switch the receiver off during the calibration process.
●● Always use a touch pen for calibration.
●● Work with extreme care.

The main view is open.
1. Tap the Settings button. The Settings menu appears.
2. Tap the Device button. The Device menu appears.
3. Switch to the Service view (Device 4/4).
4. Tap Calibration. The calibration begins.
5. Follow the instructions.
−− The individual steps must be completed within a limited
time. If the time limit is exceeded, the calibration process
will be aborted.
−− The active area is marked with crosshairs. Non-active areas are grey.
−− Blue crosshairs: Set area
−− Red crosshairs: Confirm area
−− Try to hit the centre of the active area as accurately as
possible.
Once the screen has been successfully calibrated, the receiver automatically switches back to the Service view.
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5.4

Care
All that is necessary to care for the components is to wipe them
down with a damp cloth.
SEWERIN recommends: Always remove significant contamination immediately.

5.5

Maintenance
SEWERIN recommends: Have the system serviced regularly by
SEWERIN Service or an authorised professional. Only regular
servicing can ensure that the system is always ready for use.
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6

Appendix

6.1

Technical data

6.1.1

C 200 receiver
Device data
Dimensions (W x D x H)
Weight
Material

225 x 62 x 155 mm
1.2 kg
polycarbonate (housing)

Certificates
Certificate
Marking

FCC, CE, IC, MIC
Contains:
FCC ID WSP-EZ1300102
IC 7994A-EZ1300102

Features
Display
Interface
Memory
Processor
Operation

5.7" TFT display, 640 x 480 pixels (VGA),
LED backlight
micro USB
90 MB (internal)
RISC 32-bit, DSP
Touch screen, ON/OFF key

Operating conditions
Operating temperature
Storage temperature
Humidity
Protection rating
Non-permitted operating
environments

-20 – 60 °C
-25 – 50 °C (briefly +60 °C)
15 – 90 % r.h., non-condensing
IP65/IP67
in potentially explosive areas
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Power supply
Power supply
Operating time, typical
Battery power
Charging time
Charging temperature
Charging voltage
Charging current
Charger

2 x lithium-ion batteries (rechargeable) [1357-0002]
> 10 h
2 x 24 Wh
< 7.5 h
0 – 40 °C
12 V
1.2 A
AC/DC adapter L (charge in case)

Data logging
Filter
Sampling rate

automatic or manual
16 bit, 24 kHz

Data transmission
Near-field radio

SDR (Sewerin Digital Radio)
2.408 – 2.476 GHz,
38 channels

Transmission frequency 433.9/434.4 MHz
444.5500/444.9875 MHz
458.5125 /458.7875 MHz
468.5/469.6 MHz
Radio range
> 500 m
>2m
Transmission bandwidth 0 – 5 kHz
0 – 12 kHz
Power
500 mW
10 mW

Additional data
Attachment option
Transport
Shipping instructions
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Quick-release fastener
Case AC 200 SK4, case SK10
UN 3481: lithium-ion batteries contained in
equipment or lithium-ion batteries packed with
equipment
net weight of battery/batteries: 0.196 kg

6.1.2

RT 200 transmitter
Device data
Dimensions
(W x D x H)
Weight
Material
Models

115 × 115 × 68 mm
115 × 115 × 244 mm with aerial
430 g (with aerial)
polycarbonate (housing)
country-specific

Certificates
Certificate
Marking

FCC, CE, IC
–– everywhere apart from USA:
Contains: 70TX-D2
–– USA only:
Contains: 70TX-D, FCC-ID:PUX70TX-D

Features
Signal light
Interface
Processor
Operation

1 LED red/green for operating status
3 LEDs green for filter
internal (USB)
DSP, 16 bit / 120 MHz
membrane keypad

Operating conditions
Operating temperature
Storage temperature
Humidity
Protection rating
Non-permitted operating
environments

-20 – 60 °C
-25 – 50 °C (briefly 60 °C)
15 – 90 % r.h. non-condensing
IP65
IP67 with aerial
in potentially explosive areas
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Power supply
Power supply
Operating time, minimum
Battery power
Charging time
Charging temperature
Charging voltage
Charging current
Charger

lithium-ion battery (rechargeable) [13570002], built-in
> 8 h (23 °C)
24 Wh
<6h
0 – 45 °C
12 V
1.2 A
AC/DC adapter L (charge in case)

Measurement
Filter
Sampling rate
Measurement ranges
Sensitivity

–– 3 bandpasses:
0 – 500 Hz, 0 – 4000 Hz, 200 – 4000 Hz
–– Notch filter
16 bit, 48 kHz
0 – 1 Vrms
automatic amplification:
163 levels (-17.25 – 89 dB)

Data transmission
Transmission frequency

Radio range
Transmission bandwidth
Communication
Power

international:
433.9/434.4 MHz
France: 444.5500/444.9875 MHz
UK:
458.5125/458.7875 MHz
USA:
468.5/469.6 MHz
> 500 m
5 kHz
0 – 4 kHz: NF
4 – 5 kHz: Control signals
analogue
500 mW

Positioning GNSS (GPS, Galileo, GLONASS)
Accuracy
Aerial
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2.5 m CEP, 50 %
integrated

Additional data
Shipping instructions

6.1.3

UN 3481: lithium-ion batteries contained in
equipment or lithium-ion batteries packed
with equipment
net weight of battery/batteries: 0.098 kg

UM 200 universal microphone
Device data
Dimensions (H × Ø)
Weight
Material
Models

123 x 45 mm (without cable)
1055 g
stainless steel
3 cable lengths available

Features
Signal light

2 LEDs white (each 15 cd)

Operating conditions
Operating temperature
Storage temperature
Protection rating
Non-permitted operating
environments

-20 – 80 °C
-25 – 80 °C
IP68
in aggressive media
in potentially explosive areas

Measurement
Measurement principle
Sensitivity

piezo microphone (analogue)
approx. 10 V/g (20 – 1000 Hz)

Additional data
Cable type
Cable length

6-pin, outer diameter 6.2 mm, tensile strength
> 3000 N
1.3 m / 2.8 m / 6 m
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6.1.4

HY 200 hydrophone
Device data
Dimensions (W × H)
Weight
Material

55 x 115 mm
700 g (without cable)
stainless steel

Operating conditions
Operating temperature
Storage temperature
Atmospheric pressure
Protection rating
Non-permitted operating
environments

-20 – 80 ºC
-25 – 80 ºC
water pressure up to 16 bar
IP68
in liquids other than water
In aggressive media
in potentially explosive areas

Power supply
Power supply

via RT 200

Measurement
Filter
Measurement principle

20 Hz high pass
piezo microphone (analogue)

Data transmission
Communication

analogue via cable with RT 200

Additional data
Cable type
Cable length

74 │ 6 Appendix

6-pin, outer diameter 6.2 mm
2.9 m

6.2

Symbols on the touch screen of the C 200 receiver
The following tables provide an overview of what the main symbols represent. The symbols can also occur in combination during the program sequence. Many symbols on the touch screen
can be displayed in different ways:
●● Coloured symbol
Function enabled, system component connected, etc.
●● Symbol greyed out
Function disabled, system component not connected, etc.
Symbol

Significance
Confirm

Symbol

Significance
Reset

Cancel

Add

Back

Interference suppression
Quality of peak

Scroll
Receiver
Transmitter
Universal microphone
Microphone unknown
Headphones

Duration of measurement
Rechargeable
battery
Battery fully
charged
Battery flat
Battery charging

Measurement settings
Device settings

Auto 1

Start measurement
Stop measurement

Manual

Auto 2

Volume
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Symbol

Significance
Volume low
Volume high
Brightness
Brightness low
Brightness high
Light on microphone
File
Charge
Filter by date
Save
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Symbol

Significance
Noises from transmitter
Noises from transmitter 1
Noises from transmitter 2
No noises from
transmitter
Listen to microphone
Signal strength
Satellite reception
No satellite reception
Crosshairs

Delete

Settings
Application
Sound velocity

Selected

Hide peak

Next

Show peak

Move

Outside 1

Zoom

Between the
transmitters
Outside 2

6.3

Significance of LED signals

6.3.1

C 200 receiver
The LED indicates the operating status.
Colour
Green

Type of signal
Light permanently on
Flashing
Double
flash

Red

Light permanently on
Flashing

Activation Significance
(repeat)
●● C 200 switched on
0.1 s on >
0.9 s off
(ongoing)
0.1 s on >
0.1 s off >
0.1 s on >
0.7 s off
(ongoing)

0.1 s on >
0.9 s off
(ongoing)

●● Battery charging
●● Battery is fully
charged

●● C 200 switched on
●● Undervoltage: Battery
needs charging
●● Error when charging
battery (temperature
below or above permitted charging temperature)
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6.3.2

RT 200 transmitter
The large LED between the two keys indicates operating statuses
(see table below).
The three small LEDs above the filter key indicate the bandpass
setting.
Colour Type of signal Activation
(repeat)
Green Light permanently on
Flashing
0.1 s on >
0.9 s off
(ongoing)
Double
0.1 s on >
flash
0.1 s off >
0.1 s on >
0.7 s off
(ongoing)
Red
Light permanently on
Flashing

78 │ 6 Appendix

Significance
●● RT 200 switched on
●● Battery charging
●● Battery is fully
charged

●● RT 200 switched on
●● Undervoltage: Battery
needs charging
0.1 s on > ●● Error when charging
0.9 s off
battery (temperature
(ongoing)
below or above permitted charging temperature)

6.4

Troubleshooting
Problems with the receiver
Problem
Possible cause
Touch screen Backlight has
black
switched off after
specified time

Battery flat
Touch screen or receiver faulty

6.5

Corrective action
●● Touch the screen >
display will light up
again
●● If necessary change
backlight time (setting: Switch off
backlight)
●● Recharge battery
●● Contact SEWERIN
Service

Accessories
Part
F8 wireless headphones
HY 200 hydrophone (set)
UM 200 microphone protector
M10 tripod
Triangle 200 carrying strap
Lap belt carrying system
Padded hand loop
AC/DC adapter L 12 V=
Vehicle cable L 12 V =

Order number
EZ13-18000
HY20-S0001
EM20-Z0201
4000-0966
3209-0022
EA20-Z1000
3209-0017
LD26-10000
ZL05-10200

Other accessories are available for the system. Please contact
our SEWERIN sales department for further information.
6.6

Declaration of conformity
Hermann Sewerin GmbH hereby declares that the C 200 receiver and RT 200 transmitter fulfil the requirements of the following
directive:
●● 2014/53/EU
The complete declaration of conformity can be found online.
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6.7

Licences in the EEA
The RT 200 transmitter may only be used in the following countries of the European Economic Area (EEA) and only at the corresponding frequencies.
Note:
Also refer to the advice regarding near-field radio in section 1.5
on page 4.
Austria

433.9000/434.4000 MHz

Belgium

455.8100/456.1500 MHz

Cyprus

433.9000/434.4000 MHz

Czech Republic

433.9000/434.4000 MHz

Denmark

433.9000/434.4000 MHz

Estonia

433.9000/434.4000 MHz

Finland

433.9000/434.4000 MHz

France

444.5500/444.9875 MHz

Germany

433.9000/434.4000 MHz

Greece

433.9000/434.4000 MHz

Hungary

433.9000/434.4000 MHz

Iceland

433.9000/434.4000 MHz

Ireland

433.9000/434.4000 MHz

Italy

433.9000/434.4000 MHz

Liechtenstein

433.9000/434.4000 MHz

Lithuania

433.9000/434.4000 MHz

Luxembourg

433.9000/434.4000 MHz

Netherlands

433.9000/434.4000 MHz

Norway

433.9000/434.4000 MHz

Poland

433.9000/434.4000 MHz

Romania

433.9000/434.4000 MHz

Spain

433.9000/434.4000 MHz

Sweden

433.9000/434.4000 MHz

Switzerland

433.9000/434.4000 MHz

UK

458.5125/458.7875 MHz
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6.8

Note about the firmware (open source software)
The firmware is based on open source software. The source code
is provided in accordance with the licence terms for this open
source software (GPL / LGPL). Sewerin GmbH stresses that it
is not responsible for the source code and it does not form part
of the services due.
The source code is available on request at cost price by emailing
info@sewerin.com.
The full licence terms can be found online www.sewerin.com.

6.9

Advice on disposal
The European Waste Catalogue (EWC) governs the disposal
of appliances and accessories in accordance with EU Directive
2014/955/EU.
Description of waste

Allocated EWC waste code

Device

16 02 13

Disposable battery,
rechargeable battery

16 06 05 / 20 01 34

Alternatively, used equipment can be returned to Hermann Sewerin GmbH.
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7

Index

A

H

Acoustic leak detection 45
Aerial 17
Auto 1 / Auto 2 32
Automatic power off 9

High pass 17
Hydrophone 19

B

Information 60
Interference suppression
active 15
operating principle 15

Bandpass 16
Blocking filter 54
Brightness 59
automatic 59

C
Calculations, number of 14
Calibration 61, 67
Coherence 55
Communication 4
Correlation curve 34
display 54
Cross spectrum 55
Current filter (button) 32

D
Data transmission 4
Date 59
Date format 60
Diameter 56

F
Filter
adjusting 35
applying 38
blocking filter 54
button 13
date 29
opening menu 35
options on the receiver 31
overview 20
selecting 35
transmitter options 16
Frequency graph 33

82 │ 7 Index

I

L
Language 60
LED 7, 17
significance 77
Length 56
License 80
Light key 17
Light sensor 7
Listening to noise 42
Lithium-ion rechargeable battery
charging 62
identifying a fault 64
removing 65, 66
transport regulations 64
Lock/unlock display 48
Low pass 17

M
Main view 9
Manual 32
Marker 12
moving 38
Material 56
Measurement
after configuring pipe sections 26
charging 28
continuing 26
deleting 30
filtering 29
measurement steps (overview) 22
noises 47
preparing 22
repeating 27
saving 27

starting 26
stopping 27
Microphone
connecting 21
Microphone function 45
Minimum noise level 47

N
Near-field radio 4
Noise level 47
Noise measurement 47

P
Peak 34
hide 39
quality 34
Pipe data
adjusting 25
Pipe section
adding 24
configuring 22
deleting 24
number 23

R
Radio connection
overview 4
when listening 42
Receiver 6
carrying the system 8
connectors 8
ports 8
switching off 9
switch off backlight 9
Result
display 10
optimising 31

Settings
button 14
device 56
enable/disable 50
measurement 52
options 49
select 50
set value 50
Set value 50
Sound velocity
measuring 40
setting 56
Spectrum 1 or Spectrum 2 55
Switch off backlight 58
Switch off device 58
Symbols 75
System
components (overview) 5
preparing 22

T
Time 59
Time format 60
Touch screen 6
calibration 67
Transmitter 15
ports 16
selecting 45
switching off 17
switching on 17

U
Units 53
Universal microphone 18

V
Volume 44, 47

S
SDR (Sewerin Digital Radio) 4
Select 50
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Hermann Sewerin GmbH

SEWERIN SARL
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Tel.: +49 5241 934-0
Fax: +49 5241 934-444
www.sewerin.com
info@sewerin.com
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Tél. : +33 3 88 68 15 15
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www.sewerin.fr
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SEWERIN IBERIA S.L.

Sewerin Portugal, Lda
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28042 Madrid, España
Tel.: +34 91 74807-57
Fax: +34 91 74807-58
www.sewerin.com
info@sewerin.es

Rua Sr. Dos Milagres, 16, 2º Esq
3800-261 Aveiro, Portugal
Tlf.: +351 234 133 740
Fax.: +351 234 024 446
www.sewerin.com
info@sewerin.pt

Sewerin Sp. z o.o.

Sewerin Ltd.

ul. Twórcza 79L / 1
03-289 Warszawa, Polska
Tel.:
+48 22 675 09 69
Tel. kom.: +48 501 879 444
www.sewerin.com
info@sewerin.pl

Hertfordshire
UK
Phone: +44 1462-634363
www.sewerin.co.uk
info@sewerin.co.uk

